RT PolarFire Device Family Enhancements Compared to :
PolarFire Devices Application Note @ MICROCHIP

I I’It I'Od u CﬁO n (Ask a Question)

The Radiation-Tolerant (RT) versions of the PolarFire® FPGA and SoC devices are based on the non-volatile and
reprogrammable PolarFire device family from Microchip, which are manufactured using 28 nm technology. This
article provides an overview of the differences between the RTPF500T and RTPF500ZT device versions. Similarly,
a comparison between the RT PolarFire SoC RTPFS###ZT devices and the PolarFire SoC MPFS###T devices is
provided. For more information about these products and user documentation, see the RT PolarFire and RT
PolarFire SoC web pages.

Document Status

The current status of this document is:
« RTPF500T: Production

* RTPF500ZT: Production

* RTPFS460ZT and RTPFS160ZT: Advance

There are three levels in the document status:

Advance Initial estimated information from simulations.
Preliminary Information based on simulation and/or initial characterization.
Production Final production data.

Important: RTPF500T is not recommended for new designs. RTPF500T is being replaced
by RTPF500ZT FPGAs.

For information about the errata associated with RTPF500T, RTPF500ZT, RTPFS460ZT and RTPFS160ZT devices,
see RT PolarFire FPGA and SoC FPGA Devices Errata.


https://www.microchip.com/askaquestion?pub_guid=GUID-7E3C1725-D946-4633-BA05-0C759465F99E&pub_lang=en-US&pub_ver=14&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-F6724D42-36D2-4BB5-BB9A-7765D3252049&cover_title=RT%20PolarFire%20Device%20Family%20Enhancements%20Compared%20to%20PolarFire%20Devices%20Application%20Note&tech_support_link=NA&revision_letter=H&source=PDF&title=Introduction
https://www.microchip.com/en-us/products/fpgas-and-plds/radiation-tolerant-fpgas/rt-polarfire-fpgas
https://www.microchip.com/en-us/products/fpgas-and-plds/radiation-tolerant-fpgas/rt-polarfire-soc
https://www.microchip.com/en-us/products/fpgas-and-plds/radiation-tolerant-fpgas/rt-polarfire-soc
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/Errata/RT_PolarFire_FPGA_and_SoC_FPGA_Devices_Errata_DS00006185.pdf
https://microchip.com
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1. High-Level Differences (sa question)

The standard device offerings for Transceivers (T), Data Security (S), Speed Grades (STD and -1),
Lower Static Power (L) and screening levels are listed in RT PolarFire Product Overview. In addition
to the standard device offerings, RTPF500T and RTPF500ZT are the two primary RT PolarFire
versions also offered. The following table lists the high-level differences between RTPF500T and
RTPF500ZT versions.

Table 1-1. High-Level Differences Between RTPF500T and RTPF500ZT

RTPF500T RTPF500ZT

Uses the same silicon as commercial PolarFire® MPF500T FPGA, Silicon design has been enhanced over RTPF500T
but with modified flip-chip die bump spacing to enable hermetically- to facilitate the added features and improved
sealed ceramic packaging and space-grade device screening flows.  performance described in this column.

User design access to system services requiring the internal system Supports on-demand access to system controller
controller are unavailable when using System Controller Suspend services after SCSM exit during normal operation.
Mode (SCSM)'.

Only supports JTAG and SPI-target in-flight reprogramming modes.  Supports JTAG, SPI-target, In-Application
Programming (IAP) and Auto-Update in-flight
reprogramming modes.

Power-loss or brownout of VDD, VDD18, or VDD25 supplies Enhanced system controller SNVM write service to
during an sNVM page write can corrupt the page, leaving it as prevent sSNVM pages from becoming read-only in the
a read-only page, preventing further page writes during design event of a power loss or brownout during a page
operation. Restoring write access to the corrupted page requires write.

reprogramming the device using a bitstream containing content for
the affected SNVM page. For more information, see PolarFire System
Services User Guide, Rev F or later.

Baseline PolarFire FPGA radiation tolerance, as documented in Enhanced radiation tolerance over RTPF500T, as
published test reports, and summarized in Radiation Tolerance. summarized in Radiation Tolerance.
No ECC on internal SNVM/pNVM data storage areas 2. Added SECDED ECC to internal SNVM/pNVM data

storage areas to mitigate heavy-ion NVM bit errors 2.

sNVM organized into 221 pages, each of which holds 252 bytes of sNVM organized into 221 pages, each of which holds
non-authenticated plaintext or 236 bytes of authenticated plaintext = 220 bytes of non-authenticated plaintext or 204 bytes
or ciphertext. of authenticated plaintext or ciphertext. The user
data storage capacity per page is reduced due to
the overhead required to implement SECDED ECC on

sNVM data.
Transceiver VDDA supply supports a voltage of 1.0V or 1.05V. A 1.0V  Transceiver VDDA supply must be 1.05V for all lane
VDDA supports lane rates less than or equal to 10.3125 Gbps. A rates. Must use —1 speed grade above 10.3125 Gbps.

1.05V VDDA can be used for all lane rates, and must be used for
rates greater than 10.3125 Gbps. Must also use -1 speed grade
above 10.3125 Gbps.

Notes:
1. For more information about which device features are accessible on RTPF500T, when SCSM is
enabled, see PolarFire Family System Services User Guide.

2. For more information, see the "pNVM/boot up failure Results" section in the RT PolarFire
RTPF500ZT Heavy lon Test Results report from LBNL, on February 6th, 2023.

The following table lists the high-level differences between PolarFire SoC MPFS###T devices and RT
PolarFire SoC RTPFS###ZT devices.

Table 1-2. Differences Between MPFSH###T and RTPFSH###ZT

MPFS160T, MPFS460T RTPFS160ZT, RTPFS460ZT

Terrestrial PolarFire® SoC devices Silicon design has been enhanced by incorporating the
changes made to RTPF500ZT, as outlined in the preceding
table, and described in this column.
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https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/ProductBrief/Radiation-Tolerant-PolarFire-FPGA-Product-Overview.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/PolarFire_FPGA_and_PolarFire_SoC_FPGA_System_Services_User_Guide_VD.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/PolarFire_FPGA_and_PolarFire_SoC_FPGA_System_Services_User_Guide_VD.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/PolarFire_FPGA_and_PolarFire_SoC_FPGA_System_Services_User_Guide_VD.pdf
https://www.microchip.com/en-us/products/fpgas-and-plds/radiation-tolerant-fpgas/radiation-and-reliability-data
https://www.microchip.com/en-us/products/fpgas-and-plds/radiation-tolerant-fpgas/radiation-and-reliability-data

Table 1-2. Differences Between MPFS###T and RTPFSH##ZT (continued)

MPFS160T, MPFS460T RTPFS160ZT, RTPFS460ZT

Non-hermetic, COTS plastic ball grid array packaging, per
PolarFire SoC Product Overview. Commercial substrate,
capacitors, and lid. MIL-Temp device and package
combinations use ruggedized vented packages.

Transceiver VDDA supply supports a voltage of 1.0V or 1.05V.
A 1.0V VDDA supports lane rates less than or equal to
10.3125 Gbps. A 1.05V VDDA can be used for all lane rates
and must be used for rates greater than 10.3125 Gbps. Must
also use —1 speed grade above 10.3125 Gbps.

Supports JTAG, SPI-target, In-Application Programming (IAP),
and Auto-Update reprogramming modes for terrestrial
applications.

Power-loss or brownout of VDD, VDD18, or VDD25 supplies
during an sNVM page write can corrupt the page, leaving it

as a read-only page, preventing further page writes during
design operation. Restoring write access to the corrupted
page requires reprogramming the device using a bitstream
containing content for the affected SNVM page. For more
information, see PolarFire Family System Services User Guide,
Rev F or later.

User design access to system services requiring the
internal system controller is unavailable when using System
Controller Suspend Mode (SCSM)'.

During SCSM, MSS soft reset (that is, reboot)

can be processed by directly connecting MSS
REBOOT_REQUESTED_M2F output to PFSOC_SCSM macro’s
SC_WAKE input. No other connections to the SC_WAKE input
are allowed.

Same baseline radiation tolerance as PolarFire and PolarFire
SoC, including the RT PolarFire RTPF500T as documented

in published test reports, and summarized in Radiation
Tolerance.

No ECC on internal sSNVM/pNVM data storage areas. For

more information on upset rate, see Radiation Tolerance and
2

sNVM organized into 221 pages, each of which holds
252 bytes of non-authenticated plaintext or 236 bytes of
authenticated plaintext or ciphertext.

PolarFire SoC Microcontroller Subsystem (MSS)

PolarFire SoC 128 KB eNVM without ECC

@ MICROCHIP

RTPFS460ZT uses modified flip-chip die bump spacing

to enable hermetically sealed, ceramic column CG1509
package.

RTPFS460ZT is also offered in RT plastic, ball grid FC(G)1509.

RTPFS160ZT is only available in RT plastic, ball grid
FCV(G)784.

RT plastic packages use RT substrate, RT capacitors, and hi-
reliability lid. Plastic packages are not hermetically sealed.

MPFS160T and RTPFS160ZT in FCV(G)784 are pin compatible.

For more information, see RT PolarFire SoC Product
Overview.

Transceiver VDDA supply must be 1.05V for all lane rates.
You must use -1 speed grade above 10.3125 Gbps.

Supports JTAG, SPI-target and enhanced In-Application
Programming (IAP) and Auto-Update in-flight programming
modes, per In-Flight Reprogramming.

Enhanced system controller SNVM write service to prevent
sNVM pages from becoming read-only in the event of a
power loss or brownout during a page write.

On-demand access to system controller services is available
after SCSM exit during normal operation.

During SCSM, the same approach is used to process MSS
reset requests. Additionally, the PFSOC_SCSM SC_WAKE input
can be driven by a dynamic user signal from the FPGA fabric,
to temporarily exit suspend mode. See System Controller
Suspend Mode (SCSM) and System Services.

Incorporates the radiation tolerance enhancements made to
the RTPF500ZT, as summarized in the Radiation Tolerance.

Added SECDED ECC to internal SNVM/pNVM data storage
areas to mitigate heavy-ion NVM bit errors 2.

sNVM organized into 221 pages, each of which holds

220 bytes of non-authenticated plaintext or 204 bytes of
authenticated plaintext or ciphertext. The user data storage
capacity per page is reduced due to the overhead required to
implement SECDED ECC on sNVM data.

Same MSS design. Additional reference design for radiation-
mitigated secure boot mode 2, using initial bootloader in ECC
protected sNVM. User boot code is encoded with software-
defined ECC and stored in eNVM. The sNVM bootloader
decodes the user eNVM boot code, copies it to ECC protected
L2 scratchpad, and executes the user boot. Application note
and reference design to be published.

Same eNVM. Software defined SECDED ECC can be applied
as mentioned. When using soft-ECC, eNVM usable space is
reduced from 128 KB to 102 KB.


https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/ProductBrief/PolarFire-SoC-Product-Overview-60001656.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/ProductBrief/Radiation-Tolerant-PolarFire-SoC-FPGA-Product-Overview-DS00005395.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/ProductBrief/Radiation-Tolerant-PolarFire-SoC-FPGA-Product-Overview-DS00005395.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/PolarFire_FPGA_and_PolarFire_SoC_FPGA_System_Services_User_Guide_VD.pdf

Notes:

1. For more information about which device features are accessible on PolarFire SoC MPFS devices
when SCSM is enabled, see PolarFire Family System Services User Guide.

2. For more information, see the "pNVM/boot up failure Results" section in RT PolarFire RTPF500ZT
Heavy lon Test Results report from LBNL, on February 6th, 2023.
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2. System Controller Suspend Mode (SCSM) (s question)

For high-reliability applications, RT PolarFire FPGAs and SoCs can be configured to hold the internal
system controller in reset after the device power-up process is complete. This is a default option for
RT PolarFire FPGAs and SoCs in the Libero® SoC design suite. The SCSM ensures that the system
controller is held in reset using a Single Event Upset (SEU) immune, self-refreshing, and TMR latch
to prevent Single Event Effects (SEEs) from causing unintended system controller operations such as
device programming or zeroization.

It is recommended to minimize the amount of time the internal system controller is active during
flight because it is not protected against SEUs. Once SCSM is active, all system controller outputs to
the FPGA fabric design go to logic "0". Therefore, it is important to configure the PF_INIT_MONITOR
and PFSOC_INIT_MONITOR IP cores to Latch system controller outputs during SCSM, especially if the
output signals are used to derive a Reset signal for the user logic.

When PolarFire (MPF), PolarFire SoC (MPFS) and RTPF500T devices are programmed with a

bitstream that enables SCSM, the system controller is held in reset upon completion of the power-
up process, assuming that the JTAG TRSTB pin is at a logic-low level. To exit SCSM during normal
operation, the JTAG TRSTB input must be driven High. After driving TRSTB high, the system controller
can be used for device programming until TRSTB returns to logic-low. SmartDebug can also be
accessed while JTAG TRSTB is driven high.

However, for PolarFire (MPF), PolarFire SoC (MPFS), and RTPF500T devices using SCSM, certain
system services that require the system controller to be active during normal design operation
are not available after the device completes the power-up process. Nevertheless, you can still
reprogram the device using one of the supported programming modes if the JTAG TRSTB pin is
driven high externally to release the system controller from reset.

On MPF, MPFS, and RTPF500T devices, when SCSM is exited, the latches used by the
PF_INIT_MONITOR or PFSOC_INIT_MONITOR IP core to latch the system controller outputs are
cleared, causing any active-low fabric resets derived from output signals such as DEVICE_INIT_DONE
to get asserted. Therefore, SCSM exit on these devices must only be performed prior to
reprogramming the device, and you can plan the system to accommodate the fabric design
entering its reset state before reprogramming. Once the device is successfully reprogrammed with
a bitstream that continues to use SCSM, you must return the JTAG TRSTB pin to a logic-low state to
re-enter SCSM.

In contrast, when using RTPF500ZT, RTPFS460ZT, and RTPFS160ZT devices, you can use the JTAG
TRSTB signal to enter and exit SCSM during normal design operation. To exit SCSM and release
the system controller from reset, drive JTAG TRSTB High. To re-enter SCSM and immediately put
the system controller into reset, set JTAG TRSTB low. Even though you still need to configure the
PF_INIT_MONITOR or PFSOC_INIT_MONITOR IP core to latch the system controller outputs when
entering SCSM on these devices, the latched values are no longer cleared when SCSM is exited
during normal operation. Additionally, during design operation, temporarily exiting SCSM enables
user access to selected system controller services. In general, it is recommended to minimize the
amount of time the system controller is active during flight to reduce the risk of SEUs.

Finally, RTPFS460ZT and RTPFS160ZT devices support an additional method to temporarily exit
SCSM during normal operation. For these devices, instantiating the PFSOC_SCSM macro serves a
dual-purpose:

1. It provides a means to process an MSS reboot request when operating with SCSM enabled, as

described in the Processing MSS Reboot Requests During SCSM. This use-model is also available
on terrestrial PolarFire SoC MPFS devices.

2. For RTPFS460ZT and RTPFS160ZT devices, it also allows user software or firmware applications
running on the MSS to exit SCSM on-demand for the purposes of running a device system
service, as described in the following sections.
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Important: To avoid incomplete transactions, make sure there are no active
Dynamic Reconfiguration Interface (DRI) transactions in progress before exiting
SCSM on RTPF500ZT, RTPFS460ZT, and RTPFS160ZT devices.

Related Links
RT PolarFire Programming User Guide
PolarFire FPGAs for Safety-Critical Applications

2.1. Processing MSS Reboot Requests During SCSM (aska question)

PolarFire SoC (MPFS###T) and RT PolarFire SoC (RTPFS###ZT) devices, when operating with System
Controller Suspend Mode (SCSM) enabled, support temporarily waking up the internal system
controller to process an MSS reboot request. The sources of an MSS reboot request include:

+ Writing to specific registers in the MSS register map to request a reset, such as the
MSS_RESET_CR.

+ Assertion of specific MSS reset input signals, such as MSS_RESET_N_F2M.
+ A watchdog timeout from WDOGO connected to the E51 Monitor Core.
+ Avresettriggered by a CPU debugger.

Important: To use a debugger, the JTAG TRST_N must be driven High to wake
the system controller and thus the device would not be in SCSM during a
debugger-initiated MSS reset.

This is accomplished by incorporating the following into the user design:

+ In the MSS Configurator, navigate to the Misc tab and select "Expose Feedback ports to Fabric" to
make the REBOOT_REQUESTED_M2F output port visible on the MSS component.

+ From the IP Catalog Macro Library, instantiate the PFSOC_SCSM primitive macro.
+ Connect the MSS output REBOOT_REQUESTED_M2F to the SC_WAKE input of the PFSOC_SCSM.

+ Instantiate the SC_STATUS primitive macro and monitor the SUSPEND_EN output to confirm
whether the system controller is suspended.

* This connection is illustrated for the PolarFire SoC MPFS devices in the "PolarFire SoC and RT
PolarFire SoC Reboot" section in the PolarFire Family Power-Up and Resets User Guide.
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3- System Se rViCES (Ask a Question)

The internal system controller provides a variety of system services as described in the PolarFire
Family System Services User Guide.

MPF, MPFS, and RTFP500T devices that are configured to use SCSM have limited access to system
services. The services available during SCSM include those that do not require the system controller
to be active during normal design operation. These include access to: user crypto co-processor, POR
digest check, tamper 10_Disable, user voltage detectors, UJTAG security monitor, and TVS. If the
tamper macro is used, it must be configured to latch the following outputs before the device enters
SCSM:

« Reset reason output
« Tamper flag [13] output for POR digest check

In contrast, the ability to temporarily exit SCSM to perform system services during normal operation
is a useful addition to the RTPF500ZT, RTPFS460ZT, and RTPFS160ZT devices. It allows additional
access to commonly used services such as:

+ sNVM access
+ Bitstream authentication service for updated bitstreams stored in the external SPI memory

+ In-Application Programming (IAP) where the RT PolarFire controls an external SPI Flash memory
containing the target bitstream.

+ Auto-Update programming service using previously authenticated bitstreams
« Data security services including digital signatures, PUF emulation and Nonce generation.
+ Device and design information

+ SPI flash memory read service to copy data from an external SPI flash to MSS memory (SoC
devices only).

Notes:

« For RTPF500ZT, RTPFS460ZT, and RTPFS160ZT devices, when exiting SCSM by driving the JTAG
TRSTB pin high, it is required to wait 0.5 ps after driving TRSTB high before requesting a system
service.

+ For RTPFS460ZT and RTPFS160ZT devices, when exiting SCSM by driving the SC_WAKE input high,
it is required to wait 0.5 ps after driving SC_WAKE high before requesting a system service.

+ If a system service is requested while the device is operating in SCSM mode, it will be ignored.
To confirm the system controller state before issuing the system service request, the user design
must monitor the SUSPEND_EN output of the SC_STATUS macro. For more information about the
SC_STATUS macro, see PolarFire Macro Library Guide.

* The user design must schedule the re-entry into SCSM by waiting for any initiated system
service to complete before re-entering SCSM. If temporary SCSM exit was performed using JTAG
TRSTB, then SCSM re-entry occurs immediately after TRSTB is returned to a low state. For the
RTPFS460ZT and RTPFS160ZT, if SCSM exit was performed using the PFSOC_SCSM SC_WAKE
input, then SCSM re-entry occurs immediately after SC_WAKE is returned to logic low.

+ After exiting SCSM on RTPF500ZT, RTPFS460ZT, and RTPFS160ZT devices during normal
operation, the system service to perform a fabric digest check is not supported. This service
powers-off the fabric and the fabric RAM block contents are not preserved. Furthermore, the
device cannot re-enter SCSM until a subsequent device power-cycle or DEVRST_N assertion and
release.

+ After exiting SCSM on RTPF500ZT during normal operation, the Dynamic Reconfiguration
Interface (DRI) is not available for I/0 related DRI read or write operations. If needed, the user
must perform I/0 related DRI transactions while SCSM is active. This limitation does not apply to
the RTPFS460ZT and RTPFS160ZT devices.
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3.1. Requesting System Controller Services Using PFSOC_SCSM (RTPFS460ZT and
RTPFS].6OZT Only) (Ask a Question)

An enhancement added to the RT PolarFire SoC (RTPFS460ZT and RTPFS160ZT) over the terrestrial
PolarFire SoC MPFS devices is the ability to drive the PFSOC_SCSM macro's SC_WAKE input High. This
is achieved by using a dynamic user logic signal, to exit SCSM and keep the system controller active,
until the signal returns to logic Low. This feature enables a user design with SCSM enabled to access
system controller services during normal operation by following these example steps:

+ The user application writes a logic-1 to an MSS GPIO output to the fabric or to a memory-mapped
fabric register connected to the PFSOC_SCSM macro’s SC_WAKE input to exit the SCSM.

« The application reads the SC_STATUS macro’s SUSPEND_EN output to confirm that the system
controller is out of suspend mode.

+ The application requests a system service that requires processing by the system controller. This
can be done using the mss_sys_services firmware drivers.

+ Upon completion of all requested system controller services, the application writes a logic-0
to SC_WAKE to re-enter suspend mode and confirms successful re-entry by monitoring the
SUSPEND_EN output.

+ Similarly, user logic in the fabric can initiate and manage the SCSM exit and re-entry
by driving the SC_WAKE input and monitoring the SUSPEND_EN output, along with the
PF_SYSTEM_SERVICES core from the Libero SoC IP catalog. Fabric logic could also include a soft
Mi-V processor that either connects to the PF_SYSTEM_SERVICES core using firmware drivers
from the Libero SoC Firmware Catalog, or uses the MSS FIC fabric initiator port to access the MSS
register-mapped system services mailbox using MSS system services firmware drivers. For more
information, see 3.

Important:

1. This feature requires Libero SoC v2025.1 or later. Using an earlier version of
Libero SoC results in a Compile error when fabric logic drives the SC_WAKE
input, because older versions enforce the same SC_WAKE connectivity rules as
PolarFire SoC MPFS###T devices.

2. Once the PFSOC_SCSM macro is instantiated using Libero SoC v2025.1 or later,
the SC_WAKE input cannot be tied to a static "1" or "0" logic value because it is
an invalid use-model and will trigger a design Compile error in Libero SoC.

3. ltis the user's responsibility to perform handshaking between MSS application
code and fabric logic if both methods are used to request system services in
the same design.

The following figure is an example showing the SC_WAKE input connected to user signals
in an RT PolarFire SoC SmartDesign canvas. Such a connection would generate an error for
a terrestrial PolarFire SoC design since the MPFS devices only allow the connection from
REBOOT_REQUSTED_M2F to SC_WAKE.
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3.2.

Figure 3-1. Connecting SC_WAKE Input to Dynamic User Signal in RT PolarFire SoC Design

RTPFS460ZT_MSS_0

[ElcLOCK_IN CLOCK[H]
B REFCLK GPIO_2[F] PFSOC_SCSM_O
WREFCLK_N GPIO_2_M2F_Op
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pGPIO_2_F2M_1 REBOOT_REQUESTED_M2Fp

SUSPEND_EN [HIRESET_IN RESETLH] PFSOC_SCSM
3¢ L
RTPFS460ZT_MSS

SC_STATUS

For examples of how to use system services, see PolarFire Family System Services User Guide.

In-Flight Reprogramming (aska auestion)

For RTPF500T devices, only JTAG and SPI target re-programming modes are supported for in-
flight reprogramming, and the process generally involves the use of an external device that
executes DirectC. Power-cycle initiated auto-updates are not recommended for RTPF500T devices.
Furthermore, system services for In-Application Programming (IAP) and auto-update are not
supported because the device must be configured to use SCSM in flight.

The enhancements to RTPF500ZT, RTPFS460ZT, and RTPFS160ZT devices add robustness checks

to the IAP and auto-update programming algorithms, allowing them to be used for in-flight
reprogramming. These checks include the addition of an extra programming verification step and

a programming digest check before the FPGA fabric is released for operation. When using IAP or
auto-update, it is important to understand the automatic recovery process triggered in the event of

a programming failure or interruption, as documented in the RT PolarFire Programming User Guide.

RTPF500ZT, RTPFS460ZT, and RTPFS160ZT devices also continue to support the JTAG and SPI target
re-programming modes.

Notes:

+  When reprogramming RTPF500T or RTPF500ZT devices, the SNVM cannot be reprogrammed
independently of the FPGA fabric.

+ Before considering in-flight reprogramming of RTPFS460ZT or RTPFS160ZT devices using
bitstreams that do not contain a fabric component, such as eNVM-only or sSNVM-only bitstreams,
it is important to review the Recommendations for Field Updates (IAP and Auto Update) table in
the PolarFire and PolarFire SoC Programming User Guide.

+ The One-Way Passcode (OWP) protocol for PolarFire SoC and RT PolarFire SoC devices is
not compatible with the Secure Production Programming Solution (SPPS) that uses Hardware
Security Modules (HSMs) and an Authorization Code bitstream component. Programming
bitstreams that use OWP are intended for use outside the SPPS environment on devices that
have already been provisioned with the desired security settings and locks. The OWP allows for
the temporary unlocking of an individual security lock to enable a programming action, such as
IAP. Attempting to use a bitstream with OWP in an SPPS environment with Authorization Code
bitstream components will result in an error. For more information about OWP, see the PolarFire
and PolarFire SoC Programming User Guide. For more information on SPPS and Authorization
Code components, see the SPPS User Guide.

For more information about the recommended programming action, such as the
REPROGRAM_INFLIGHT action for in-flight reprogramming, see RT PolarFire Programming User
Guide and DirectC User Guide.

The following table summarizes the SCSM exit behavior differences between MPF###T, RTPF500T,
RTPF500ZT, MPFS###T and RTPFS###ZT devices, as described in the preceding sections.

@ MICROCHIP


https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/PolarFire_FPGA_and_PolarFire_SoC_FPGA_System_Services_User_Guide_VD.pdf
https://www.microchip.com/askaquestion?pub_guid=GUID-7E3C1725-D946-4633-BA05-0C759465F99E&pub_lang=en-US&pub_ver=14&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-FEF4865E-CB4A-4FE1-A55B-17DC44B2C60F&cover_title=RT%20PolarFire%20Device%20Family%20Enhancements%20Compared%20to%20PolarFire%20Devices%20Application%20Note&tech_support_link=NA&revision_letter=H&source=PDF&title=In-Flight%20Reprogramming
https://www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/programming-and-debug/embedded-programming
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/RT_PolarFire_FPGA_Programming_User_Guide_VB.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/PolarFire_FPGA_and_PolarFire_SoC_FPGA_Programming_User_Guide_VB.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/PolarFire_FPGA_and_PolarFire_SoC_FPGA_Programming_User_Guide_VB.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/PolarFire_FPGA_and_PolarFire_SoC_FPGA_Programming_User_Guide_VB.pdf
https://ww1.microchip.com/downloads/aemdocuments/documents/fpga/core-docs/Libero/2021_2/Tool/spps_ug.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/RT_PolarFire_FPGA_Programming_User_Guide_VB.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/RT_PolarFire_FPGA_Programming_User_Guide_VB.pdf
https://www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/programming-and-debug/embedded-programming#Documentation

Table 3-1. System Controller Suspend Mode (SCSM) Exit Behavior Differences

Device Exit SCSM through JTAG

Exit SCSM

TRSTB = HIGH for Device | through JTAG

Reprogramming

PolarFire® Yes (for terrestrial
(MPF###T) environments)
RTPF500T Yes, for JTAG or

SPI Target In-Flight
Reprogramming Only

RTPF500ZT Yes

PolarFire SoC Yes (for terrestrial
(MPFS###T) environments)

RT PolarFire Yes

SoC (RTPFS160ZT,

RTPFS460ZT)
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Radiation Tolerance (s auestion)

The following table summarizes the radiation tolerance differences between RTPF500T and
RTPF500ZT.

Table 4-1. Radiation Tolerance Differences

Total lonizing Dose (TID) performance Maintains datasheet parameters at 100 krad

FPGA Configuration Upsets (Firm Errors), Zero observed at LET 80 MeV-cm2/mg

including yPROM

Flip-Flop SEU rate without synthesized 1.3 x 107 errors/bit-day (GEO solar min)

TMR

Flip-Flop SEU rate with synthesized 1.2 x 10717 errors/bit-day (GEO solar min)

spatial TMR

Fabric LSRAM block SEU rate without 4.7 x 108 errors/bit-day (GEO solar min)

ECC

Fabric LSRAM block SEU rate with 4.7 x 101> errors/bit-day (GEO solar min)

optional SECDED ECC enabled

Reset circuit SEFI rate Estimated at 1 spontaneous, self-recoverable, device reset in 187 years (GEO solar
min)

Fabric uSRAM block SEU rate without 2.3 x 108 errors/bit-day (GEO solar min)

EDAC

Fabric uSRAM block SEU rate using 9.5 x 10710 errors/bit-day (GEO solar min)

CoreEDAC soft IP

SEU rate for internal NVM storage Exhibits 1 failure in 362,397 years Zero observed NVM data errors at

including user sSNVM and system of operation (GEO solar min)—sNVM LET = 80 MeV-cm2/mg

controller pNVM upset impacts sNVM data integrity and

For more information, see the "pNVM/ pNVM upset impacts device power-up to

boot up failure Results" section in the functional process

RT PolarFire RTPF500ZT Heavy lon Test
Results radiation report.

SEL for HSIO bank No SEL observed on HSIO

SEL for GPIO bank at 3.3V + 5% VDDI and SEL LET7y > 25 MeV-cm2/mg at room SEL LET7H = 37 MeV-cm2/mg.

VDDAUX temp. Destructive SEL at LET = 48 MeV- Destructive SEL at LET = 45 MeV-

cm?/mg at 87°C cm?2/mg at 100°C

SEL for GPIO bank at 2.5V + 5% VDDI and SEL LETyH = 58 MeV-cm2/mg SEL LET7y = 80 MeV-cm2/mg

VDDAUX

SEL for GPIO bank at 1.8V + 5% VDDI and SEL LETyH > 58 MeV-cm2/mg SEL LET7y = 80 MeV-cm2/mg

2.5V + 5% VDDAUX

SEL for XCVR bank REFCLK inputs at 2.5V SEL LETyH = 58 MeV-cm2/mg SEL LET7y = 80 MeV-cm2/mg

+ 5% VDD_XCVR_CLK

micro-SEL for fabric ESD clamp Fabric ESD clamps exhibit micro-SEL on No fabric ESD clamp micro-SEL

VDD25/VDDA25 (12 to 30 mA per micro-  observed on VDD25/VDDA25 at LET =

SEL) with 1 micro-SEL every 27 years in 80 MeV-cm2/mg

GEO solar min

In short, the RTPF500ZT contains enhancements to the silicon design that achieve the following
improvements over the initial RTPF500T devices:

+ Elimination of SEL for GPIO bank I/Os using 2.5V + 5% VDDI and VDDAUX at LET = 80 MeV-cm?2/mg
+ Elimination of fabric ESD clamp micro-SEL on VDD25/VDDA25 at LET = 80 MeV-cm2/mg
+ Zero observed NVM data errors at LET = 80 MeV-cm2/mg

+ Confirmed by heavy-ion beam testing. For more information on radiation tolerance of other
device features, see the latest test reports on the Radiation Test Report web page.
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Important: The guidelines for high-frequency decoupling capacitor usage, for 1/0
bank power supplies on the RTPF500T, must be strictly followed, as stated in the
RT PolarFire Board Design User Guide.

The RT PolarFire SoC RTPFS460ZT and RTPFS160ZT devices include the same radiation tolerance
enhancements as the RTPF500ZT. Therefore, the enhanced SEL performance measured on the
RTPF500ZT, as shown in the preceding table, are expected to apply to RTPFS460ZT and RTPFS160ZT
devices as well. Once confirmed through radiation testing, the table above will be updated further to
include the RT PolarFire SoC devices. Similarly, RTPFS460ZT and RTPFS160ZT devices have the same
FPGA fabric radiation performance as the RTPF500ZT.

As mentioned in Table 1-2, the same MSS design is used for both PolarFire SoC and RT PolarFire
SoC devices. However, with the addition of ECC on the internal sNVM, RTPFS460ZT, and RTPFS160ZT
devices support an enhanced, radiation-mitigated, secure boot mode 2, compared to MPFS###T
devices. In this boot mode, the following events occur:

1. The initial bootloader is stored in ECC-protected sNVM.

2. The user boot code is encoded with software-defined ECC before being stored in the device
eNVM.

3. During boot-up, the system controller copies the sNVM bootloader into E51 instruction memory,
and the E51 monitor core executes the initial bootloader.

4. The initial SNVM bootloader decodes and copies the user eNVM boot code into ECC protected L2
scratchpad memory, correcting single bit errors along the way.

- Double-bit errors can flag an error to an external host or trigger an IAP from a golden image.
5. The MSS then executes the user eNVM boot code from ECC protected L2 scratchpad memory.

An application note and reference design will be published to release this enhanced boot-mode 2
for RT PolarFire SoC devices.

For the results of the MSS Radiation Tests, see the latest reports on the Radiation Test Report web
page.
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5. Device Compatibility Between RTPF500T and RTPF500ZT (- auestion)

This section discusses the compatibility of designs targeting RTPF500T and RTPF500ZT. The
enhancements made to the RTPF500ZT did not change the design of the FPGA fabric or the CG1509
package.

5.1. Package Compatibility (as«aquestion)

RTPF500T and RTPF500ZT devices in the 1509-pin Ceramic Column Grid Array (CCGA) package are
pin and footprint compatible. The CG1509 package design is identical between the two devices.
Therefore, a board designed for the RTPF500T in CG1509 package can also use the corresponding
RTPF500ZT in CG1509 package without requiring any board changes. Furthermore, the user's
top-level design pin assignments for RTPF500T do not require any changes when migrating to
RTPF500ZT.

The RTPF500ZT device is also available in a high-reliability plastic FC(G)1509 package. The RTPF500ZT
in FC(G)1509 is pin compatible with both the RTPF500T and RTPF500ZT devices in the CG1509
package. For screening flow details and differences between the FC(G)1509 versus the CG1509, see
RT PolarFire FPGA Product Overview.

5.2.  Bitstream Compatibility (askaquestion)

RTPF500T and RTPF500ZT programming bitstreams are not compatible with each other. When
designing for RT PolarFire FPGAs in Libero SoC, the user must select the appropriate device part
number in the project settings or new project wizard. Attempting to program an RTPF500ZT device
with a programming bitstream designed for RTPF500T, or vice versa, results in an error and the
device is not programmed. The addition of SECDED EDAC on RTPF500ZT internal sSNVM and pNVM
storage necessitated a change to the programming bitstream, preventing bitstream compatibility
between the two device versions. The Libero SoC design flow step that generates the design
initialization data has been updated to employ SECDED EDAC when the RTPF500ZT is selected.

Important: An RTPF500T design that has used 100% of the internal SNVM
storage cannot be directly migrated to RTPF500ZT because of the extra storage
overhead required to store user SECDED ECC protected data in sNVM. In

this scenario, Libero SoC generates an error during the Generate Design
Initialization Data design flow step. The user must re-run the Configure Design
Initialization Data and Memories step to reduce the amount of SNVM data
storage used by the design.

5.3. Design Migration from RTPF500T to RTPF500ZT (aska question)

Since the two devices in CG1509 are package pin and footprint compatible, requiring no board
changes when migrating from RTPF500T to the corresponding RTPF500ZT, the instructions in
Appendix 1: Device Migration Process from RTPF500T to RTPF500ZT Using Libero SoC can be
followed to migrate a completed, placed and routed RTPF500T design to a RTPF500ZT design with
no changes in placement or routing.

Important: RTPF500T is not recommended for new designs. RTPF500T is being
replaced by RTPF500ZT FPGAs.
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6.1.

6.2.

Device Compatibility Between MPFS###T and RTPFS###ZT Devices (s

Question)

The PolarFire SoC MPFS devices and RT PolarFire SoC RTPFS###ZT devices share the same FPGA
Fabric and MSS design. Therefore, user application code designed to run on the MSS is portable
between these devices. Similarly, FPGA fabric user logic is portable between these devices, with
similar area and timing results, except for the typical variations possible between tool flow

runs. However, as described in this document, several enhancements have been added to RT
PolarFire SoC devices to make them more suitable for space applications. In addition to the built-in
enhancements, users must also consider what changes are required to software, firmware, and
fabric logic designs to incorporate mitigations for upsets, depending on the mission reliability
requirements and the device radiation test reports. Such changes could include synthesized local
TMR, distributed TMR, and high-reliability FPGA fabric coding styles.

Similarly, the MSS boot mode selected by the user for RTPFS designs could differ from that used

by an MPFS design, such as the enhanced boot mode 2 described in the preceding section.
Furthermore, when prototyping RTPFS designs using MPFS, or migrating from MPFS to RTPFS, users
should also account for the slightly reduced sNVM storage due to built-in ECC, as well as reduced
eNVM storage when using software ECC and the enhanced boot mode 2.

PaCkage Com patibility (Ask a Question)

The following table summarizes the package pin compatibility between RT PolarFire SoC devices and
other PolarFire devices.

RT PolarFire SoC Device | Package Pin Compatible With

PolarFire SoC (MPFS) | PolarFire FPGA RT PolarFire FPGA RT PolarFire SoC (RTPFS)
(MPF) (RTPF500T and
RTPF500ZT)

RTPFS160ZT in FCV(G)784 Yes; MPFS160T in None None None
FCV(G)784I
RTPFS460ZT in FC(G)1509 None None None Yes; RTPFS460ZT in CG1509
RTPFS460ZT in CG1509 None None None Yes; RTPFS460ZT in
FC(G)1509

Bitstream Com pati bility (Ask a Question)

RT PolarFire SoC (RTPFS) bitstreams are not compatible with PolarFire SoC bitstreams (MPFS). When
designing for RT PolarFire SoCs in Libero SoC, the user must select the appropriate device part
number in the project settings or new project wizard.
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https://www.microchip.com/askaquestion?pub_guid=GUID-7E3C1725-D946-4633-BA05-0C759465F99E&pub_lang=en-US&pub_ver=14&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-721FE3D5-8659-4BF7-B185-7CE6265F12AD&cover_title=RT%20PolarFire%20Device%20Family%20Enhancements%20Compared%20to%20PolarFire%20Devices%20Application%20Note&tech_support_link=NA&revision_letter=H&source=PDF&title=BitStream%20Compatibility

7. I/0 Bank Voltages saauestion)
You must be familiar with the Single-Event Latch-up (SEL) risks for GPIO banks as described in
Radiation Tolerance and the RT PolarFire Radiation Test Reports before selecting 2.5V or 3.3V I/Os.

When designing for RTPF500T, RTPF500ZT, RTPFS460ZT, and RTPFS160ZT devices in Libero SoC, the
default project settings are configured to generate an error and stop the design flow if 3.3V I/0
standards are used on GPIO banks. This setting is accessed from Project Menu > Project Settings >

Design Flow Settings.
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8. Appendix 1: Device Migration Process from RTPF500T to RTPF500ZT
USing LiberO SOC (Ask a Question)

The enhancements made to the RTPF500ZT do not impact the FPGA fabric design, and thus user
design content remains unchanged between the two devices. Therefore, a Libero® SoC project that
has been placed and routed for RTPF500T can be updated to target RTPF500ZT when migrating

between device versions.

The following figure shows the Libero SoC project settings window, where the users can change the
target device die setting for a completed and finalized RTPF500T design.

Figure 8-1. Change Device Selection

@
Device selection
Device settings Currently selected device is RTPFS00ZTS-1CG1509M Save
Design flow
Analysis operating conditions Part filter Discard
= Simulation options
DO file " Family: ‘Fc\arF\re J Die: |AH j Package: ‘A\I ﬂ
Waveforms
Veim commands Speed: |All - Range: |All -
Timescale
= Simulation libraries Reset filters
PolarFire X )
General Settings BB Warning
Global Include Paths
SmartDesign Search part: | The changes you made may invalidate your components and/or design flow;
Part Number 1 you may have to regenarate your components and rerun your design flow. |H'Ch\p Globals | PLL ‘ DLﬂ
Do you wish to continue?
RTPF300TL-CG1509M 423 8 8
RTPF500TLS-CG1509M Yes No 48 8 8
RTPF300TS-1CG1509M 423 8 8
/ RTPF500T5-CG1509M 481272 632 4440 1520 1480 48 8 8
RTPF500ZT-1CG1509M 481272 632 4440 1520 1420 42 8 8
RTPF300ZT-CG1509M 481272 632 4440 1520 1420 43 g g
RTPF300ZTL-CG1508M 481272 632 4440 1520 1480 48 8 8
\ RTPF500ZTLS-CG1509M 431272 632 4440 1520 1420 43 2 2
481272 632 4440 1520 1480 48 8 8
|R'TFSOOZT’S—CGWSOQM 481272 632 4440 1520 1480 ‘ 43 g N
‘ 3

When using the Libero SoC managed design flow starting with HDL source files, changing the

target device die invalidates the Libero SoC design state back to the pre-synthesis stage. In

contrast, when using the Custom Flow, where the final top-level Libero SoC project starts with a
synthesized mapped-Verilog netlist (. v file), changing the target device invalidates the design to
the pre-compile state. When the synthesized netlist is the design source file for the RTPF500T Libero
SoC project, the same netlist can be used as the starting point for the updated project targeting the
RTPF500ZT, without resynthesizing.

In general, when using the same input source files, computer platform, tool versions, and tool
settings (other than the target device), the tool flow can be re-run using the Incremental Place and
Route setting to recreate the previously completed place and route result.

Important: The following considerations help to ensure a smooth Libero SoC
design migration from RTPF500T to RTPF500ZT:

+ The final state of the RTPF500T project determines whether the exact place and route results can
be repeated after changing the target device selection to RTPF500ZT.

+ Ensure that the pin assignment in the final RTPF500T design is locked using 1/0 Editor or a PDC
file with -fixed true argumenton each set io constraint.

+ Ensure that all logical instances in the final RTPF500T design have a locked placement in the Chip
Planner tool and that the corresponding user floor-planning PDC file is enabled in the Constraint

Manager.
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« In general, it is recommended to archive (zip) the original completed RTPF500T project before
modifying the target device.

Do not change the Libero SoC or Synopsys® Synplify Pro® tool versions when migrating the
design.

+ Do not change project or tool settings other than the device die selected during the migration.

« Do not change any input source files, constraint files, or file organization/associations during the
migration.

« For consistent and repeatable results, ensure the migrated RTPF500ZT project design flow is run
using the same OS and comparable CPU type (for more information, see Note) as the computer
used to create the final RTPF500T design.

+ Plan ahead for migration from RTPF500T to RTPF500ZT by starting the final top-level RTPF500T
Libero SoC project using the synthesized . vM netlist along with the final constraint files. This
avoids re-synthesizing the HDL source files during the design migration, ensuring the input
source files to the Libero SoC incremental place and route process are unchanged.

The following figures from the 1/0 Editor accessed by selecting Edit in the Constraints Manager's
170 Attributes tab, highlight all top-level I/0 pins and I/0 bank settings in the RTPF500T design are
locked:

Figure 8-2. 1/0 Editor Pinout Locked

BB 1/0 Editor - Ci/test/test_Z_mig/RTPF_SpW_v2024p1_VM (top)

File Edit View Logic | Tools Help
[ f‘l f"‘: € 1/0 Bank Settings (_E Sl e m @-\ e
Main Object Browser 1 Aute-AssignVOBanks 8 Tactive] & | Pinview & | xcvRView & | MemoryView & | 10D View & | Package View & |
l—‘# s Rul.es T Port Name t| Direction |¥| 1/0Standard |¥| Pin Number | ¥ I:J;;i " A
Ports & @|_]x]| 0 W PF_SPACEWIRE_RX_PHY_C0_0(rate=200) ﬁ
: gg g&("::ﬁ“ I SpW_0_DATA_IN_P[0] LVDS25
12 SpW_0_DATA_IN_N[0] LVDS25
13 | SpW_0_STROBE_IN_P[0] VD ETl
14 | SpW_0_STROBE_IN_N[0] LVDS25
15 | REF_CLK_0 LVCMOS25 B16
16 | W RODATAD O
7| RX_DATA_0[0] LVCMOS25 H14
13 | RX_DATA_O[1] LVCMOS25 GN
19 | w spw.oRrdcLk O
2 | SpW_0_RX_CLK[0] LVCMOS25 H13
En SPW_TK_CLK LVCMOS25 c4
2 | SpW_TX_DATA_P LVDS25 D4
23 | SpW_TK_DATA_N LVDS25
24 | SpW_TX_STROBE_P LVDS25 E7
25 | SpW_TX_STROBE_N LVDS25
26 | START LVCMOS25 A8
m{f\ Logical /\_Net /\_Region / O

Figure 8-3. 1/0 Bank Settings Locked

W 1/0 Bank Settings

Bank

Choose Bank: |Bank2— GPIO j v Locked
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The corresponding I/0 PDC file used in the Constraint Manager contains set_io constraints with
argument -fixed true.

Figure 8-4. User PDC with set_io -fixed true

Reports & X |  Constraint Manager & X ¢ User.pdc @ X |

¢ = = A+ A- x—

[ [ ] —

ag

100 set_ic -port name {SpW_0 STRCBE IN N
101 -pin name E12

102 —fixed true

103 -io_s=std LVD525

104 -DIRECTION INPUT

105

106

107 set_io -port _name {SpW_ 0 STROBE IN P
108 -pin_name E11

109 —fixed true

110 -io =td LVDS525

111 -DIRECTION INPUT

The design pin report also reflects that the user pin assignment is fixed.

Figure 8-5. Pin Report Fixed I/O

Reports & X | Constraint Manager & X | Timing Report Explorer 51x|

- Project Surmmary

: |E]AII @ocErrors 4.0 warnings @0 Info
=} top reports

|»

-~ Components —Product: Designer
= Compile Metlist _ -Release: v2024.1
- top_compile_netlist_resourcesxml _Version: 2024.1.0.3

- top_compile_netlist_hier_resources.csv
- top_compile_ioff.xml

0 top_compile_netlist.log

[=- Place and Route

-Design Hame: top
—Family: PolarFire
—-Die: RIPFS00TS
—-Package: CG1509

- top_glb_net_report.xml e e——
- top_layout_combinational_leops.xml L= ﬁﬂ

- top_place_and_route_constraint_coverage, 3 3

- place_and_route_jitter_report. Port : Pin : Function

- top_pinrpt_number.rpt Clk err Inj L5 Yes GPIO307PB2/
- top_pinrpt_boardlayout.csv cnten C3 Yes GPIO309PB2/
- top_pinrpt_boardlayoutxmi cntout[24] El4 Yes GPIO1NB2

- top_bankrpt.rpt cntout [25] E13 Yes GFICL1PB2

-~ top_delayinstance.rpt cntout [26] Fl14 Yes GPIOONBZ

- top_layout_ioff xml cntout [27] F13 Yes GPIOOPBZ

The following figures from the Chip Planner accessed by selecting Edit in the Constraint Manager
from Floor Planner tab, highlight how the user can ensure the final RTPF500T design locks the
placement of all logical instances and that the floor-planning user . pdc file written out by the Chip
Planner is enabled for use in the design.

The user can right-click the hierarchical root node in the Logical view of the Main Object Browser in
Chip Planner to Lock Placement or use the Logic Menu -> Lock All option from the menu bar.
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Figure 8-6. Lock Placement through Chip Planner Right-Click on Root Logical Node

[ ] Chip Planner - Ciftestftest 7 mig/RTPF_SpW_v2024p1_VM

File Edit View Logic Tools Floorplanner View Help

] |22 ) 2 |

Main Object Browser

g X

|
#  fltop

'@ Place to Locations
4'@ Unplace From location

L Lock Placement

& Unlock Placement

Region Assign

=]

Logical ilrﬁl _"’IE'
B

\_Port_/\ Logical /%_Net /\_Region /

OR
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Figure 8-7. Using Chip Planner Logic Menu to Lock All Instance Placement

B Chip Planner - Ciftestftest 7 mig/RTPF_SpW _v20
File Edit View l@ Tools  Floorplanner View

JJJ - |£’1 | Unplace Al

Lock All Ctrl+H

Main Object Brow: 5
Unlock All  Ctrl+5hift+H

|— .,
Logical &|®| £t

T top
1} Primitives
T+ CORERESET PF CO0
1 PFCCC COD
T+ PF_INIT_ MONITOR_CO 0
& D PFI0_C0.0
8 @] pPFi0_C1.0
1T PFOSC COO
1 PF SPACEWIRE_RX_PHY CO O
T+ counter28 0
T+ data_strobe_gen_0
T+ input_sync_0
T+ input_sync_1
T+ input_sync_2

{_Port /\ Logical /\_Net /%_Region /

Use the File > Commit or click the toolbar icon to save the change and write-out a floor-planning
user.pdc file:

Figure 8-8. Commit Placement Chip Planner

[ ] Chip Planner - Ciftest/test 7 mig/RTPF_SpW_v202

File Edit View Logic Tools Floorplanner View

M@------“-' o o]+

3'” GquCommlthr 5 X
]
Logical FIS

8 4F top

\Port_/\ Logical /i Tet /% Region /

The user.pdc file is automatically saved into <path to project>/constraint/fp/user.pdc

Enable the usage of the floor-planning user PDC containing the locked placement for all logical
instances in the Constraint Manager > Floor Planner tab:

21
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Figure 8-9. Enable Usage of Fixed Placement PDC and Save Constraint Manager Floor Planner

4l

Reports & X ] Timing Report Explorer & X Constraint Manager & X l

1O Attributes | Timing  Fioor Planner] Netiist Attributes |
MNew ‘ Import ‘ Link | Edit ‘ View ‘ Chedk ‘ Help e' Discard ﬂ ﬂ
—
T

| Place and Route
constraint\fp\user.pdc [ Target ]

p—

The following figure shows an example of the floor-planning PDC file generated by locking the
placement of all logical instances in the completed design.

Figure 8-10. Placement PDC Fixed True

# Microchip Physical design constraints file

# Version: 2024.1 2024.1.0.3

$# Design Hame: top

# Family: PolarFire , Die: RTPFS500TS , Package: CG1l509 , Speed grade: -1
Core cell constraints

ECRE R

set_location -inst_name PF_INII‘_I-IDNII‘OR_I:C'_C',"PF_INIT_I-IDNIIDR_CCI_C'."I_5'.151:End_HDde_Saft_IP_Inst/J
true -x 414 -y 4

set_location -inst name PF_CCC CO O/PF CCC CO Ofclkint 0/U0 RGBl —fixed true -x 57% -y 12

set_ location -inst name {data_strobe_gen_O,’sthD_erI_int_Cl['_
set_location -inst _name {CORERESET PF CO_O/CORERESET PF CO_0/dff S[C

—fixed true -x 177 -y 4

Once the preceding considerations have been made, rerunning the incremental Libero SoC design
flow to generate the final RTPF500T design bitstream puts the design into a state that ensures the
user can obtain the same place and route results after migrating the project’s device die setting to
the corresponding RTPF500ZT device.

The following is a summary of the migration steps.
1. Prerequisites for Migration and RTPF500T Final Design State:
- Use the same Libero SoC and Synplify Pro tool version.
- Use the same input source files, constraint files, file organization, and associations.
- Use the same tool settings, other than the device die setting which is being migrated.
- Run the design software on the same OS and CPU type (for more information, see Note).

- The final pin assignment must be locked in the graphical I/0 Editor or have equivalent set_io
commands with -fixed true andthel/O user.pdc file must be enabled in the Constraint
Manager.

- The finalized RTPF500T design bitstream must be obtained after rerunning the incremental
design flow with locked instance placement and the corresponding user floor-planning
PDC enabled in the Constraint Manager. That final project state must be achieved before
using the RTPF500T design to perform final hardware/system testing and before migrating
to RTPF500ZT to ensure the same fabric Place and Route result and fabric digest after
migration.
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O Tip: In general, different CPU generations should produce the same results

for floating-point arithmetic used in FPGA Place and Route algorithms, if
those CPUs use the same precision and follow the IEEE®-754 standard for
floating point arithmetic. However, when running an FPGA Place and Route
algorithm on different CPU architectures, it is theoretically possible to arrive
at different place and route results due to small computational differences.
For the specific RTPF500T to RTPF500ZT migration guidance in this document,
where the user is instructed to use a locked placement and incremental Place
and Route, the impact of the CPU type should be minimized.

2. Libero SoC Design Migration Steps:To migrate the Libero SoC design, perform the following
steps:

a.
b.

In Libero SoC, open the final RTPF500T design (ensuring that a backup copy exists)

To change the Device Selection to the corresponding RTPF500ZT die, navigate to the Project
> Project Settings... window and save the changes.

+ The design state will be invalidated to pre-Synthesis state (if the design started with HDL
source files) or pre-Compile state (if the design started with a synthesized netlist (. vM).

To enable Incremental Place and Route, right-click the design flow step and select Configure
Options...

For the Libero SoC managed design flow, where the project uses RTL source files as inputs,
re-run the Libero SoC design flow, including re-running Synthesis, Incremental Place and
Route, and Generate Bitstream.

OR

For the Custom Flow, where Synthesis is performed outside of Libero SoC and the
synthesized .vM netlist is the input source file to the Libero project, do not re-run Synthesis.
Instead, re-run the Libero SoC design flow from netlist Compile, including Incremental Place
and Route, and Generate Bitstream design flow steps.

Review the following files to confirm that the place and route result is unchanged between
the RTPF500T and RTPF500ZT designs:

i. The layout log for the RTPF500ZT project must indicate that there were 0
nets incrementally routed. The log is found at: <path to project>/Designer/
<top name>/<top name> layout log.log

ii. The <top name> generateBitstream.log contains the design CHECKSUM and Fabric
component bitstream digest. Compare these values in the migrated RTPF500ZT project to
the RTPF500T project. If these values are the same, it means the two projects have used
the same place and route results and the fabric content in the programming bitstream is
identical.

Complete the appropriate design flow steps under Hand-off Design for Production to
ensure that the files used for production hand-off are specific to the RTPF500ZT device.
This includes re-exporting the Design Initialization Data and Memory Report to obtain
updated design-specific power-up to functional time (PUFT) estimates. After migrating to the
RTPF500ZT, re-exporting this report will account for the added PUFT overhead of decoding
the SECDED ECC protected sNVM initialization data during device initialization performed
by the internal system controller. As long as the design follows published guidance in the
PolarFire Family Power-Up and Resets User Guide and PolarFire FPGAs for Safety-Critical
Applications application note regarding device initialization process, PolarFire Initialization
Monitor output signal usage, and latching system controller outputs during suspend mode,
the user design will be held in reset until the device initialization completes.

The following figures show how to enable Incremental Place and Route.
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Figure 8-11. Configure Layout Options

Place and Route I

Edit Post Layout Design Run
=- b Verify Post Layout Impl Clean and Run All
> +| Generate Back Annol  Clean

B
&1 Verify Timing enfigure Options...

>&1 Open SmartTime Help
o o} Verify Power

Figure 8-12. Enable Incremental Place and Route

N Layout Options

- [v Timing-driven
™ Power-driven

r 1/0 Register Combining
[+ Global Pins Demotion
I Driver Replication

r High Effart Layout

r Repair Minimum Delay Violations

v Incremental Layout

™ Use Multiple Passes

Configure... |
Help | 0K Cancel

The following figures show excerpts from the layout log during Incremental Place and Route where 0
nets are re-routed.

Figure 8-13. Layout Log 1

#x&aa% Place and Boute Configurations *#*##%%

Timing-driven : ON

Power-driven : OFF
I/0 Register Combining : OFF
Glokal Pins Demotion : CH

Driver Replication : OFF
High-effort : OFF
Repair min-delay : OFF

Incremental : ON %

Inter-clock optimization : ON
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Figure 8-14. Layout Log 2

Running the I/0 Bank and Globals Assigner.
Info: I/0 Bank and Globals Assigner is running in hncxemental mode. Pre-assigned I/0 Bank technologies and cells will not ke changedl
Info: I/0 Bank and Globals Assigner identified 18 fixed I/0 macros, O unfixed I/0 macros

Info: I/0 Bank and Globals Assigner identified bank 'Bank2' as being fixed at VCCI:2.50V VCCR:n/a

Since the RTPF500T final design includes a fixed placement floor-planning PDC for all logical
instances, and the input source files have not changed in the RTPF500ZT project, the placer
completes quickly, as shown in the following log excerpt.

Figure 8-15. Layout Log 3

Flacer Runtime Summary

Clustering (1 pass) : 0 seconds
Flacement : 0 seconds
Inprovement : 0 seconds

Flacer completed successfully.

Figure 8-16. Layout Log 4

Info: Eouted 0 net(s) incrementally.

Router completed successfully.

The following figure shows an example of the generateBitstream. log highlighting the design
CHECKSUM and Fabric component bitstream digest values that must be compared for consistency
across the RTPF500T and migrated RTPF500ZT designs.

Figure 8-17. Generate Bitstream Log

Software Version: 2024.1.0.3

Opened 'C:\test\test_Z mig\RTPF_SpW_v2024pl VM\designer\top\top_ fp\top.pro'

PDB file 'C:\test\test_Z mig\RTPF_SpW_vw2024pl VM\designer\top\top.pdb' has been loaded successfully.
DESIGN : top; CHECKSUM : DE%3; PDE VERSION : 1.9

Load Programming Data(s) Finished : Thu Jun 06 12:14:44 2024 (Elapsed time 00:00:00)

OInfD: Programming Interface selected is JIAG.

File/Folder 'C:\test\test_Z mig\RTPF_SpW_v2024pl VM\designer\top\top.ppd' will be overwritten.

Successfully exported PPD file for currently secured device: 'C:\test\test_Z mig\RTPF SpW_v2024pl VM\designer\top\top.ppd':
file programs Fabric and sHVM.

BITS component bitstream digest: f185dcdc588fccd25cf2e26a2a6b39%:317cTcd244655359%a122a409fb252d8=223

Fabric component bitstream digest: fdllcb8913ff18c891d%:=bi21a73e0dd2de342e24e30cd742a5952de43af0388

F\FM component bitstream digest: 9017595a7babafél2kbl2ef0ck5d96343fce5£6e453E£7517ad990fa33cfe11445

ECB component bitstream digest: 2a052ab24ddd57012177919%b1d0ed8d4c49eal3T7b865914dbfealEe73259240a74

Entire bitstream digest: 96f6bTbeb46f2115cTEf3606a6ce5a4f8097c59462bd9f4513710054a4bE7588

Finished: Thu Jun 06 12:15:49 2024 (Elapsed time 00:01:05)
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9- COI’IC'USiOﬂ (Ask a Question)

This application note is intended to clearly distinguish the supported features and radiation
performance of the RT PolarFire RTPF500T and RTPF500ZT devices. Similarly, this document
highlights the enhancements made to the RT PolarFire SoC RTPFS460ZT and RTPFS160ZT devices
over MPFS###T devices. Planning the system design according to the documented device specific
capabilities allows you to choose the device most suited for the application requirements,
operational environment, and production schedule.
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10. Revision History s aueston)

The revision history describes the changes that were implemented in the document. The changes
are listed by revision, starting with the most current publication.

H 01/2026 The following is the list of changes made in this revision.

Added a note about RT PolarFire® RTPF500ZT Heavy lon Test Result and cross referenced the same
in Table 1-1 and Table 1-2 in the High-Level Differences section.

Made the following changes in the Radiation Tolerance section:
- Updated Table 4-1 with RT PolarFire® RTPF500ZT Heavy lon Test Result weblink.

- Updated the note by clearly stating that the decoupling capacitors usage for I/0O Bank power
supplies must be strictly followed on RTPF500T.

G 10/2025 The following is the list of changes made in this revision.

From Revision G onwards, the Errata section describing the usage of external VERIFY_DIGEST
JTAG/SPI action for fabric component digest on devices configured to perform POR fabric digest
checks has been moved to the RT PolarFire FPGA and SoC FPGA Devices Errata document.

Added a note regarding RTPF500T device in the Introduction and Design Migration from RTPF500T to
RTPF500ZT sections.

Figure 3-1 was updated to use an OR gate to combine multiple sources that drive the SC_WAKE input
to the PFSOC_SCSM macro.

F 07/2025 The following is the list of changes made in this revision.

The document was updated to include enhancements in RT PolarFire® SoC RTPFS460ZT and
RTPFS160ZT devices compared to other PolarFire devices.

The document title was changed from "Differences Between RT PolarFire RTPF500T and RTPF500ZT
FPGAs" to "RT PolarFire Device Family Enhancements Compared to PolarFire Devices".

Added section for describing a limitation on the usage of external VERIFY_DIGEST JTAG/SPI action
for fabric component digest on devices configured to perform fabric Power-On-Reset (POR) digest
checks and a section for Processing MSS Reboot Requests During SCSM.

Table 4-1 was updated to include the temperature test conditions for the SEL data on GPIO banks
running at 3.3V in the Radiation Tolerance section.

The steps to migrate a completed design from RTPF500T to RTPF500ZT were moved into Appendix 1.

E 12/2024 The following is the list of changes made in this revision.

Added Transceiver VDDA supply voltage difference in Table 1-1.

Updated System Controller Suspend Mode (SCSM) to indicate that System Controller Suspend Mode
(SCSM) can be exited by driving JTAG TRSTB High.

"System Controller Suspend Mode (SCSM) Exit Behavior Differences" table was added for
summarizing the SCSM exit behavior differences in the In-Flight Reprogramming section.

Updated Table 4-1 in the Radiation Tolerance section to reflect the latest SEL LET thresholds for 3.3V
GPIO banks on RTPF500T, as per the RT PolarFire FPGA Single Event Latch-Up Test Report Revision B.

D 10/2024 The following is the list of changes made in this revision.
Updated Design Migration from RTPF500T to RTPF500ZT section as follows:

@ MICROCHIP

Added a note under the Prerequisites for Migration and RTPF500T Final Design State: in Design
Migration from RTPF500T to RTPF500ZT, to clarify the meaning of using the same CPU type as that
used to complete the RTPF500T design, when re-running the tool flow for the migrated RTPF500ZT
design.

Added a final step to Libero SoC Design Migration Steps in Design Migration from RTPF500T to
RTPF500ZT section, as a reminder to re-export the migrated RTPF500ZT design specific files for
production hand-off, including the Design Initialization Data and Memory Report.
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https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/Errata/RT_PolarFire_FPGA_and_SoC_FPGA_Devices_Errata_DS00006185.pdf

Revision History (continued)

C 07/2024 The following is the list of changes made in this revision:

Added Device Compatibility Between RTPF500T and RTPF500ZT section that includes a new section
on Package Compatibility, the pre-existing section on Bitstream Compatibility

Updated Libero SoC Design Migration Steps in Design Migration from RTPF500T to RTPF500ZT
section.

B 05/2023 . |n Table 1-1, added a row to highlight the difference in SNVM data storage capacity for storing
plaintext and ciphertext.
+ Updated Table 4-1, as follows:
- Clarified that the Configuration Upset immunity applies to both the FPGA fabric and the yPROM
configuration cells.
- Added a row describing SEL results for GPIO bank VDDI and VDDAUX at 3.3V + 5%, in RTPF500T
and RTPF500ZT.
- Added a row describing SEL results for GPIO bank VDDI = 1.8V £ 5% and VDDAUX = 2.5V, in
RTPF500T and RTPF500ZT.
« In Radiation Tolerance, added a note that points to the guidelines to be followed for high frequency
decoupling capacitor usage for I/0 bank power supplies.
+ In Radiation Tolerance and I/0 Bank Voltages, added link to Radiation Test Reports.
A 02/2023 Initial Revision

@ MICROCHIP


https://www.microchip.com/en-us/products/fpgas-and-plds/radiation-tolerant-fpgas/radiation-and-reliability-data

Microchip FPGA Support

Microchip FPGA products group backs its products with various support services, including
Customer Service, Customer Technical Support Center, a website, and worldwide sales offices.
Customers are suggested to visit Microchip online resources prior to contacting support as it is
very likely that their queries have been already answered.

Contact Technical Support Center through the website at www.microchip.com/support. Mention the
FPGA Device Part number, select appropriate case category, and upload design files while creating a
technical support case.

Contact Customer Service for non-technical product support, such as product pricing, product
upgrades, update information, order status, and authorization.

«  From North America, call 800.262.1060
*  From the rest of the world, call 650.318.4460
+ Fax, from anywhere in the world, 650.318.8044

@ MICROCHIP
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Microchip Information

Trademarks

The “Microchip” name and logo, the “M" logo, and other names, logos, and brands are registered
and unregistered trademarks of Microchip Technology Incorporated or its affiliates and/or
subsidiaries in the United States and/or other countries (“Microchip Trademarks"). Information
regarding Microchip Trademarks can be found at https://www.microchip.com/en-us/about/legal-
information/microchip-trademarks.

ISBN: 979-8-3371-2728-6

Legal Notice

This publication and the information herein may be used only with Microchip products, including

to design, test, and integrate Microchip products with your application. Use of this information

in any other manner violates these terms. Information regarding device applications is provided
only for your convenience and may be superseded by updates. It is your responsibility to ensure
that your application meets with your specifications. Contact your local Microchip sales office for
additional support or, obtain additional support at www.microchip.com/en-us/support/design-help/
client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP “AS IS”. MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY

OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR
PURPOSE, OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR

ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO
MICROCHIP FOR THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk,

and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages,
claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any Microchip intellectual property rights unless otherwise stated.

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

+ Microchip products meet the specifications contained in their particular Microchip Data Sheet.

« Microchip believes that its family of products is secure when used in the intended manner, within
operating specifications, and under normal conditions.

« Microchip values and aggressively protects its intellectual property rights. Attempts to breach the
code protection features of Microchip products are strictly prohibited and may violate the Digital
Millennium Copyright Act.

+ Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its
code. Code protection does not mean that we are guaranteeing the product is “unbreakable”.
Code protection is constantly evolving. Microchip is committed to continuously improving the
code protection features of our products.

@ MICROCHIP
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